
 

 

 

MASTER VENDOR AGREEMENT 
 

 
1. Applicability. 

 

(a) These terms and conditions of purchase (these “Terms”) are the only terms which 

govern the purchase of the goods (“Goods”) and services (“Services”) by ResProp Management 

Company LLC (“ResProp”), on behalf of owners of managed properties (each individually the 

“Owner” and, ), from the vendor named on the Purchase Order and/or Statement of Work 

(“Vendor”). Notwithstanding anything herein to the contrary, if a written contract signed by both 

parties is in existence covering the sale of the Goods and Services covered hereby, the terms and 

conditions of said contract shall prevail to the extent they are inconsistent with these Terms. 
 

(b) The accompanying purchase order (the “Purchase Order”) and/or Statement of 

Work (the “SOW”) and these Terms (collectively, this “Agreement”) comprise the entire 

agreement between the parties, and supersede all prior or contemporaneous understandings, 

agreements, negotiations, representations and warranties, and communications, both written and 

oral. These Terms prevail over any of Vendor's general terms and conditions of sale regardless 

whether or when Vendor has submitted its sales confirmation or such terms. This Agreement 

expressly limits Vendor's acceptance to the terms of this Agreement. Fulfillment of a Purchase 

Order and/or a SOW constitutes acceptance of these Terms. 
 

2. Delivery of Goods and Performance of Services. 
 

(a) Vendor shall deliver the Goods in the quantities and on the date(s) specified in the 

Purchase Order or as otherwise agreed in writing by the parties (the “Delivery Date”). If no delivery 

date is specified, Vendor shall deliver the Goods within five (5) business days of Vendor's receipt 

of the Purchase Order. If Vendor fails to deliver the Goods in full on the Delivery Date, ResProp 

may terminate this Agreement immediately by providing written notice to Vendor and Vendor 

shall indemnify ResProp against any losses, claims, damages, and reasonable costs and expenses 

directly attributable to Vendor's failure to deliver the Goods on the Delivery Date. 
 

(b) Vendor shall deliver all Goods to the address specified in the Purchase Order (the 

“Delivery Point”) during ResProp's normal business hours or as otherwise instructed by ResProp. 

Vendor shall pack all goods for shipment according to ResProp's instructions or, if there are no 

instructions, in a manner sufficient to ensure that the Goods are delivered in undamaged condition. 

Vendor must provide ResProp prior written notice if it requires ResProp to return any packaging 

material. Any return of such packaging material shall be made at Vendor's risk of loss and expense. 
 

(c) Vendor shall provide the Services to ResProp, as agent of Owner, as described and 

in accordance with the Purchase Order and/or SOW and in accordance with the terms and 

conditions set forth in these Terms. 
 

(d) Vendor acknowledges that time is of the essence with respect to Vendor's 

obligations hereunder and the timely delivery of the Goods and Services, including all performance 

dates, timetables, project milestones and other requirements in this Agreement.  
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3. Quantity. If Vendor delivers more or less than the quantity of Goods ordered, ResProp may 

reject all or any excess Goods. Any such rejected Goods shall be returned to Vendor at Vendor's sole risk 

and expense. If ResProp does not reject the Goods and instead accepts the delivery of Goods at the increased 

or reduced quantity, the Price for the Goods shall be adjusted on a pro-rata basis. 
 

4. Shipping Terms. The Purchase Order number must appear on all shipping documents, 

shipping labels, invoices, correspondence and any other documents pertaining to the Purchase Order. 
 

5. Title and Risk of Loss. Title and risk of loss passes to ResProp upon delivery of the Goods 

at the Delivery Point. 
 

6. Inspection and Rejection of Nonconforming Goods. ResProp has the right to inspect the 

Goods on or after the Delivery Date. ResProp, at its sole option, may inspect all or a sample of the Goods, 

and may reject all or any portion of the Goods if it determines the Goods are nonconforming or defective. 

If ResProp rejects any portion of the Goods, ResProp has the right, effective upon written notice to Vendor, 

to: (a) rescind this Agreement in its entirety; (b) accept the Goods at a reasonably reduced price; or (c) reject 

the Goods and require replacement of the rejected Goods. If ResProp requires replacement of the Goods, 

Vendor shall, at its expense, within five (5) business days replace the nonconforming or defective Goods 

and pay for all related expenses, including, but not limited to, transportation charges for the return of the 

defective goods and the delivery of replacement Goods. If Vendor fails to timely deliver replacement 

Goods, ResProp may replace them with goods from a third party and charge Vendor the cost thereof and 

terminate this Agreement for cause pursuant to Section 16. Any inspection or other action by ResProp under 

this Section shall not reduce or otherwise affect Vendor's obligations under the Agreement, and ResProp 

shall have the right to conduct further inspections after Vendor has carried out its remedial actions. 
 

7. Price. The price of the Goods and Services is the price stated in the Purchase Order and/or 

the SOW (the “Price”). If no price is included in the Purchase Order, the Price shall be the price set out in 

Vendor's published price list in force as of the date of the Purchase Order and/or SOW. Unless otherwise 

specified in the Purchase Order and/or the SOW, the Price includes all packaging, transportation costs to 

the Delivery Point, insurance, customs duties and fees and applicable taxes, including, but not limited to , 

all sales, use or excise taxes. No increase in the Price is effective, whether due to increased material, labor 

or transportation costs or otherwise, without the prior written consent of ResProp. 
 

8. Payment Terms. FAILURE TO COMPLY WITH THE FOLLOWING TERMS WILL 

RESULT IN A DELAY OF PAYMENT TO VENDOR. Vendor shall issue an invoice to ResProp on or 

any time after the completion of delivery and only in accordance with these Terms. ResProp, on behalf of 

Owner, shall pay all properly invoiced amounts due to Vendor within thirty (30) days after ResProp's receipt 

of such invoice, except for any amounts disputed by ResProp in good faith. Without prejudice to any other 

right or remedy it may have, ResProp reserves the right to set off at any time any amount owing to it by 

Vendor against any amount payable by ResProp to Vendor. In the event of a payment dispute, ResProp 

shall communicate to Vendor via email or written notice no later than fifteen (15) days prior to the date 

payment is due on the disputed invoice listing all disputed items and providing a reasonably detailed 

description of each disputed item. Amounts not so disputed are deemed accepted and must be paid, 

notwithstanding disputes on other items, within the period set forth in this Section 8. The parties shall  seek 

to resolve all such disputes expeditiously and in good faith. Vendor shall continue performing its obligations 

under this Agreement notwithstanding any such dispute. For the avoidance of doubt, Vendor acknowledges 

that all payment responsibility is that of the Owner and not ResProp and ResProp shall have no financial 

responsibility under this contract for invoiced amounts. 
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(a) Vendor must submit invoices through ResProp’s Coupa Supplier Portal 

(“Coupa”) in accordance with the instructions attached hereto as Exhibit A. Vendor 

acknowledges and agrees that their invoices will not be paid unless all of the following has 

occurred: 
 

(i) Vendor has submitted a Certificate of Insurance that complies with 

Section 15 of this Agreement. 
 

(ii) Vendor has submitted an executed W-9 and/or all other tax 

documentation legally required to be on file with ResProp 
 

(iii) Vendor submitted invoice through Coupa in accordance with 

Exhibit A. 
 

(iv) Vendor has a valid PO and/or SOW for all invoices 
 

(b) ResProp will not be responsible for any late fees if Vendor fails to comply with 

all payment terms detailed in this Section 8. 
 

9. Vendor's Obligations Regarding Services. Vendor shall: 
 

(a) before the date on which the Services are to start, obtain, and at all times during 

the term of this Agreement, maintain, all necessary licenses, permits, and consents and comply with 

all relevant laws applicable to the provision of the Services; 
 

(b) comply with all rules, regulations and policies of ResProp, including security 

procedures concerning systems and data and remote access thereto, building security procedures, 

including the restriction of access by ResProp to certain areas of its premises or systems for security 

reasons, and general health and safety practices and procedures; 
 

(c) maintain complete and accurate records relating to the provision of the Services 

under this Agreement, including records of the time spent and materials used by Vendor in 

providing the Services in such form as ResProp shall approve. During the term of this Agreement 

and for a period of two (2) years thereafter, upon ResProp's written request, Vendor shall allow 

ResProp to inspect and make copies of such records and interview Vendor personnel in connection 

with the provision of the Services; 
 

(d) obtain ResProp's written consent, which shall not be unreasonably withheld or 

delayed, prior to entering into agreements with or otherwise engaging any person or entity, 

including all subcontractors and affiliates of Vendor, other than Vendor's employees, to provide 

any Services to ResProp (each such approved subcontractor or other third party, a “Permitted 

Subcontractor”). ResProp's approval shall not relieve Vendor of its obligations under the 

Agreement, and Vendor shall remain fully responsible for the performance of each such Permitted 

Subcontractor and its employees and for their compliance with all of the terms and conditions of 

this Agreement as if they were Vendor's own employees. Nothing contained in this Agreement shall 

create any contractual relationship between ResProp and any Vendor subcontractor or supplier; 
 

(e) require each Permitted Subcontractor to be bound in writing by the confidentiality 

provisions of this Agreement, and, upon ResProp's written request, to enter into a  
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non-disclosure or intellectual property assignment or license agreement in a form that is 

reasonably satisfactory to ResProp; 
 

(f) ensure that all persons, whether employees, agents, subcontractors, or anyone 

acting for or on behalf of the Vendor, are properly licensed, certified or accredited as required by 

applicable law and are suitably skilled, experienced and qualified to perform the Services; 
 

(g) ensure that all of its equipment used in the provision of the Services is in good 

working order and suitable for the purposes for which it is used, and conforms to all relevant legal 

standards and standards specified by ResProp; and 
 

(h) keep and maintain any ResProp equipment in its possession in good working order 

and shall not dispose of or use such equipment other than in accordance with the ResProp's written 

instructions or authorization. 
 

10. Change Orders. ResProp may at any time, by written instructions and/or drawings issued 

to Vendor (each a “Change Order”), order changes to the Services. Vendor shall within five (5) business 

days of receipt of a Change Order submit to ResProp a firm cost proposal for the Change Order. If ResProp 

accepts such cost proposal, Vendor shall proceed with the changed services subject to the cost proposal and 

the terms and conditions of this Agreement. Vendor acknowledges that a Change Order may or may not 

entitle Vendor to an adjustment in the Vendor's compensation or the performance deadlines under this 

Agreement. 

 

 

11. Warranties. 
 

(a) Vendor warrants to ResProp that all Goods will: 
 

(i) be free from any defects in workmanship, material and design; 
 

(ii) conform to applicable specifications, drawings, designs, samples and 

other requirements specified by ResProp; 
 

(iii) be fit for their intended purpose and operate as intended; 
 

(iv) be merchantable; 
 

(v) be free and clear of all liens, security interests or other encumbrances; 

and 
 

(vi) not infringe or misappropriate any third party's patent or other 

intellectual property rights. 
 

These warranties survive any delivery, inspection, acceptance or 

payment of or for the Goods by ResProp; 
 

(b) Vendor warrants to ResProp that it shall perform the Services using personnel of 

required skill, experience and qualifications and in a professional and workmanlike manner in 

accordance with generally recognized industry standards for similar services and shall devote 

adequate resources to meet its obligations under this Agreement; and 
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(c) the warranties set forth in this Section 11 are cumulative and in addition to any 

other warranty provided by law or equity. Any applicable statute of limitations runs from the date 

of ResProp's discovery of the noncompliance of the Goods or Services with the foregoing 

warranties. If ResProp gives Vendor notice of noncompliance pursuant to this Section, Vendor 

shall, at its own cost and expense, within five (5) business days (i) replace or repair the defective 

or nonconforming Goods and pay for all related expenses, including, but not limited to, 

transportation charges for the return of the defective or nonconforming goods to Vendor and the 

delivery of repaired or replacement Goods to ResProp, and, if applicable, (ii) repair or re-perform 

the applicable Services. 
 

12. General Indemnification. Vendor shall defend, indemnify and hold harmless ResProp and 

ResProp's parent company, its subsidiaries, affiliates, successors or assigns and its respective directors, 

officers, shareholders and employees (collectively, “Indemnitees”) against any and all loss, injury, death, 

damage, liability, claim, deficiency, action, judgment, interest, award, penalty, fine, cost or expense, 

including reasonable attorney and professional fees and costs, and the cost of enforcing any right to 

indemnification hereunder and the cost of pursuing any insurance providers (collectively, “Losses”) arising 

out of or occurring in connection with the Goods and Services purchased from Vendor or Vendor's 

negligence, willful misconduct or breach of the Terms. Vendor shall not enter into any settlement without 

ResProp's prior written consent. 
 

13. Intellectual Property Indemnification. Vendor shall, at its expense, defend, indemnify and 

hold harmless ResProp and any Indemnitee against any and all Losses arising out of or in connection with 

any claim that ResProp's or Indemnitee's use or possession of the Goods or use of the Services infringes or 

misappropriates the patent, copyright, trade secret or other intellectual property right of any third party. In 

no event shall Vendor enter into any settlement without ResProp's or Indemnitee's prior written consent. 
 

14. Limitation of Liability. Nothing in this Agreement shall exclude or limit (a) Vendor's 

liability under Sections 12 and 13 hereof, or (b) Vendor's liability for fraud, personal injury or death caused 

by its negligence or willful misconduct. 
 

15. Insurance. During the term of this Agreement, Vendor shall, at its own expense, maintain 

and carry insurance in full force and effect which includes, but is not limited to, commercial general liability 

(including product liability) in a sum no less than $1,000,000 per claim/$2,000,000 aggregate of all  claims, 

employer’s and public liability insurance with limits of $100,000 each accident, $100,000 each employee, 

$500,000 policy limit; and worker’s compensation insurance as required by any applicable federal or state 

law with financially sound and reputable insurers ranked “A-“ or better. Upon ResProp's request, Vendor 

shall provide ResProp with a certificate of insurance from Vendor's insurer evidencing the insurance 

coverage specified in these Terms. The certificate of insurance shall name Avesta Homes LLC, and ResProp 

Management Company LLC as an additional insured. Vendor shall provide ResProp with thirty (30) days 

advance written notice in the event of a cancellation or material change in Vendor's insurance policy. Except 

where prohibited by law, Vendor shall require its insurer to waive all rights of subrogation against Vendor's 

insurers and Vendor. ResProp reserves the right to adjust these insurance requirements at any time and will 

provide Vendor the updated requirements at least thirty (30) days prior to the requirements going into effect.  
 

16. Compliance with Law. Vendor shall comply with all applicable laws, regulations and 

ordinances. Vendor shall maintain in effect all the licenses, permissions, authorizations, consents and 

permits that it needs to carry out its obligations under this Agreement. 
 

17. Termination. In addition to any remedies that may be provided under these Terms, ResProp 

may terminate this Agreement with immediate effect upon written notice to the Vendor, either before  or 

after the acceptance of the Goods or the Vendor's delivery of the Services, if Vendor has not 
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performed or complied with any of these Terms, in whole or in part. If the Vendor becomes insolvent, files 

a petition for bankruptcy or commences or has commenced against it proceedings relating to bankruptcy, 

receivership, reorganization or assignment for the benefit of creditors, then the ResProp may terminate this 

Agreement upon written notice to Vendor. If ResProp terminates the Agreement for any reason, Vendor's 

sole and exclusive remedy is payment for the Goods received and accepted and Services accepted by 

ResProp prior to the termination. 
 

18. Waiver. No waiver by ResProp of any of the provisions of this Agreement is effective 

unless explicitly set forth in writing and signed by ResProp. No failure to exercise, or delay in exercising, 

any right, remedy, power or privilege arising from this Agreement operates, or may be construed, as a 

waiver thereof. No single or partial exercise of any right, remedy, power or privilege hereunder precludes 

any other or further exercise thereof or the exercise of any other right, remedy, power or privilege. 
 

19. Confidential Information. All non-public, confidential or proprietary information of 

ResProp, including but not limited to, specifications, samples, patterns, designs, plans, drawings, 

documents, data, business operations, customer lists, pricing, discounts or rebates, disclosed by ResProp  to 

Vendor, whether disclosed orally or disclosed or accessed in written, electronic or other form or media, and 

whether or not marked, designated or otherwise identified as “confidential” in connection with this 

Agreement is confidential, solely for the purpose of performing this Agreement and may not be disclosed 

or copied unless authorized in advance by ResProp in writing. Upon ResProp's request, Vendor shall 

promptly return all documents and other materials received from ResProp. ResProp shall be entitled to 

injunctive relief for any violation of this Section. This Section does not apply to information that is: (a) in 

the public domain; (b) known to Vendor at the time of disclosure; or (c) rightfully obtained by ResProp on 

a non-confidential basis from a third party. 
 

20. Force Majeure. No party shall be liable or responsible to the other party, nor be deemed to 

have defaulted under or breached this Agreement, for any failure or delay in fulfilling or performing any 

term of this Agreement, when and to the extent such party's (the “Impacted Party”) failure or delay is caused 

by or results from the following force majeure events (“Force Majeure Event(s)”): (a) acts of God; 

(b) flood, fire, earthquake, or explosion; (c) war, invasion, hostilities (whether war is declared or not), 

terrorist threats or acts, riot or other civil unrest; (d) government order, law, or action; (e)  embargoes or 

blockades in effect on or after the date of this Agreement; (f) national or regional emergency; and (g) other  

similar events beyond the control of the Impacted Party. The Impacted Party shall give notice within three 

(3) days of the Force Majeure Event to the other party, stating the period of time the occurrence is expected 

to continue. The Impacted Party shall use diligent efforts to end the failure or delay and ensure the  effects 

of such Force Majeure Event are minimized. The Impacted Party shall resume the performance of its 

obligations as soon as reasonably practicable after the removal of the cause. In the event that the Impacted 

Party's failure or delay remains uncured for a period of thirty (30) days following written notice given by it 

under this Section 20, the other party may thereafter terminate this Agreement upon five (5) days' written 

notice. 
 

21. Assignment. Vendor shall not assign, transfer, delegate or subcontract any of its rights or 

obligations under this Agreement without the prior written consent of ResProp. Any purported assignment 

or delegation in violation of this Section shall be null and void. No assignment or delegation shall relieve 

the Vendor of any of its obligations hereunder. ResProp may at any time assign or transfer any or  all of its 

rights or obligations under this Agreement without Vendor's prior written consent to any affiliate or to any 

person acquiring all or substantially all of ResProp's assets. 
 

22. Relationship of the Parties. The relationship between the parties is that of independent 

contractors. Nothing contained in this Agreement shall be construed as creating any agency, partnership, 
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joint venture or other form of joint enterprise, employment or fiduciary relationship between the parties,  

and neither party shall have authority to contract for or bind the other party in any manner whatsoever.  
 

23. Governing Law. All matters arising out of or relating to this Agreement are governed by 

and construed in accordance with the internal laws of the State of Texas without giving effect to any choice 

or conflict of law provision or rule (whether of the State of Texas or any other jurisdiction) that would cause 

the application of the laws of any jurisdiction other than those of the State of Texas.  
 

24. Submission to Arbitration. Any controversy or claim arising out of or relating to this 

Agreement, or the breach thereof, shall be settled by arbitration administered by the American Arbitration 

Association in accordance with its Commercial Arbitration Rules, and judgment on the award rendered by 

the arbitrator(s) may be entered in any court having jurisdiction thereof. 
 

25. Notices. All notices, requests, consents, claims, demands, waivers and other 

communications hereunder (each, a “Notice”) shall be in writing and addressed to the parties at the 

addresses set forth on the face of the Sales Confirmation or to such other address that may be designated 

by the receiving party in writing. All Notices shall be delivered by personal delivery, nationally recognized 

overnight courier (with all fees pre-paid), facsimile (with confirmation of transmission) or certified or 

registered mail (in each case, return receipt requested, postage prepaid). Except as otherwise provided in 

this Agreement, a Notice is effective only (a) upon receipt of the receiving party, and (b) if  the party giving 

the Notice has complied with the requirements of this Section. 
 

26. Severability. If any term or provision of this Agreement is invalid, illegal or unenforceable 

in any jurisdiction, such invalidity, illegality or unenforceability shall not affect any other term or provision 

of this Agreement or invalidate or render unenforceable such term or provision in any other jurisdiction. 
 

27. Survival. Provisions of these Terms which by their nature should apply beyond their terms 

will remain in force after any termination or expiration of this Agreement including, but not limited to, the 

following provisions: Insurance, Compliance with Laws, Confidential Information, Governing Law, 

Submission to Arbitration and Survival. 
 

28. Amendment and Modification. These Terms may only be amended or modified in a writing 

stating specifically that it amends these Terms and is signed by an authorized representative of each party . 
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EXHIBIT A 
 

 

(attached) 
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COUPA SUPPLIER PORTAL 
PO Backed Invoice Supplier Guide 

 
 
 
 

 
 
 
 
 
 

 
 
 

 
 
 
 

 
 
 
 

 

 
 
 

 

© Copyright 2016 Coupa Software Inc. All Rights Reserved. 
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Coupa Supplier Portal (CSP)  
 

Registering for CSP 
Registering for the Coupa supplier portal provides an easy way to manage information, view purchase 

orders, and create and manage invoices and online catalogs. You will receive an email notification with 

an invitation to connect to the Coupa Supplier Portal, similar to the example below.  

 

 
1. Click the link provided in the email to register. From the registration site, you can also request an 

invitation. 

2. Once you have registered, log in using your credentials. 

 

Supplier Portal Home Page 

After logging in, you will see the supplier portal home page. The CSP home page provides a snapshot of 

your company’s info. Companies searching for potential suppliers on the CSP will see only public profiles. 
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Item Description 

Default Public Profile Displays your company’s public profile 

information. 

Merge Accounts Allows you to consolidate accounts if you have 

more than one on the supplier portal. 

Latest Customers Displays a list of your current customers. 

 

 
The Menu button allows you to navigate within the 

CSP. 

 

 
Use the Notification button to set up notification 

preferences. 

 

 
When you have a new alert Notifications display in 

red with the number of new alerts. 

 

 
The Help button displays the online help and help 

tour. 
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Menu 

The Menu button helps you navigate through the system. From the Menu, you can create invoices, 

update your company’s profile, and invite additional users to join the CSP.  

 

 
Item Description 

Orders This is where you can find purchase orders sent 

by your customers. 

Invoices This is where you create and manage invoices to 

send to your customers. 

Catalogs This is where you create and manage customer- 

specific catalogs 

Profile This is where you create, modify, and manage 

your public and customer-specific profiles, and 

manage which remit-to addresses each customer 

can use. 

Admin This is where you can manage users, merge 

requests, and your remit-to addresses 

My Account This is where you can manage your person 

profile. 

Log Out. Use this to log out of the CSN. 
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Notifications 

You can view new notifications and make changes to your notifications preferences. Click Notifications > 

gear icon to access the Notifications Preferences page. Here, you can see the types of notifications you 

can select from, and how you want to view them, via email or the CSP. If neither is selected, notifications 

for that item will not be sent. 

 

 
 

If you choose not to receive online notifications, you can go to Notifications > See all to 

view them in your My Notifications page. 
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CSP Help and Support 

For additional information while using the CSP, click Help > Online Help. Here, you will find helpful topics 

and definitions for using the supplier portal. You can also click. Help > Help Tour to see a quick 

navigation demo of the supplier portal. 

 

 
If you require technical assistance, please send an email to supplier@coupa.com. 

 

 

Updating Your Company Profile 
Using CSP you can easily update your company’s profile. 

 
1. From the Menu, click Profile. 

2. Select the profile you wish to edit from the Profile drop down menu. 

3. Click Edit Profile. Make any desired changes to your profile. 

4. Click Save when you have finished making changes. 

 
 

 

Inviting Additional Users 
Using the supplier portal, you can invite additional users in your company access to the CSP. 

 
1. From the Menu, click Admin. 

2. Click Invite User. 

 

Fields marked with an asterisk (*) are required fields. 
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3. Enter the user’s information. 

4. Select which permissions the user should be able to access. 

5. Select which customer(s) the user should be able to access. 

6. Click Send Invitation. The employee will receive an email notification, with a link to register. 

 
 

 

Adding a Remit To Address 
CSP includes remit-to addresses as part of electronic invoice compliance. You must add a remit to 

address before you can create an invoice. 

 
1. From the Menu, click Admin. 

 

 

To deactivate a user, you must edit the user record and select Deactivate User. 
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2. Click Remit To link. 

3. Click Add Remit To. 

 

 
4. Once you have filled out the remit to address fields, click Add. 

 

Address (information required) 
 

Item Description 

Remit To Name A unique easily identifiable user-friendly name. 

Remit To Code Use this field to tie your CSP remit-to address with 

the corresponding address in your ERP. 

Address Line 1, 2 Standard address information. 

City Name of the city. 

State Name of the state. 

Postal Code Five digit postal code. 

Country Country of origin. 

Tax Country Determines the origination country for tax 

purposes. 

 
Remit To Contact 

This is optional contact information for the remit-to address. 
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Assign Customers 

Here, you can choose which customers will be able to see a specific remit-to address. 

 
 

 

Purchase Orders 
The purchase orders page is where you work with orders from your customers. The Purchase Orders 

table lists all the POs you've received from that customer. You can use the search bar to filter the list with 

a search term, or click the View dropdown to perform advanced filtering. See Custom Views for more info 

about advanced filtering. 

 
1. From the Menu, click Orders. 

2. Click Orders. The Purchase Order screen displays all your purchase orders. The first time you 

use the orders page, you'll have to choose a customer. To see orders from a specific customer, 

select the customer from the dropdown list just under the menu button. The next time you visit the 

orders page, it'll return to the last customer you chose. 

 

 
3. To view the detail for an individual PO, click the PO number. 

 
Column Description 

PO Number This is the purchase order number generated by 

Coupa. 

Order Date This is the date the purchase order was created 

on. 

Status This is the current status of the purchase order. 

See the Status table for more information. 

 

If you merge accounts, your remit-to addresses won't be merged unless you make them 

available for All customers. Once the merge is complete, you can again assign the remit- 

to address to the specific customers you want.  
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Column Description 

Acknowledged You can choose to let your customer know that 

you received their PO by selecting the 

Acknowledged checkbox on the purchase order. 

When you select the checkbox, the current date 

appears in the Acknowledge column. 

 
This checkbox is a simple toggle, so you can also 

un-acknowledge an invoice by deselecting the 

checkbox. If you re-acknowledge at a later time, 

the new date will appear. 

Items Items List of items on the PO. 

Unanswered Comments You can now make comments directly on the 

purchase order for your customers to see. If your 

customer has left comments that you haven't 

responded to, you'll get notified here. 

Total This is the total amount of the purchase order. 

Actions 
Use the gold coins icon to flip the PO into an 

invoice and the red coins icon to create a 

credit note. 

 

 
Status Description 

Buyer Hold The PO is approved but pending buyer review. 

Cancelled The order has been cancelled, and doesn't need 

to be fulfilled. 

Closed The issued PO has been received and was then 

closed, either manually or automatically within 

Coupa. 

Currency Hold The PO is on hold due to a currency exchange 

rate issue. 

Error There's something wrong with the PO. Contact 

your customer to get the PO back on track. 

Issued The PO has been approved and sent to the 

supplier. 

Supplier Window Hold The PO was approved outside of the order 

window schedule under contract terms. 
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Creating an Invoice 

You can create an invoice directly from the purchase order. 

 

1. From Purchase Orders, click the gold coin ( ) icon in the Action’s column of the PO you wish 

you create an invoice from. 

2. Fill out any required fields marked with an asterisk (*). 

3. Use the Calculate button to see invoice totals prior to submitting. 

4. Click Submit. If you want to save a draft now, and continue to work on the form later, click Save 

as draft instead. 

 

 

If you click on the purchase order number to view the PO, and then use the back button 

to return to the Purchase Orders page, you'll need to refresh the page to see any 

changes you made to the PO. 
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Item Description 

Invoice # This is a required field. You will need to enter your 

invoice number. 

 

 
Invoice numbers cannot exceed 

16 characters. 

Invoice Date The invoice date will default to the date the 

invoice is created. 

Payment Terms This field displays the code for your current 

payment terms that were agreed upon between 

your company and the supplier. 

Currency Displays the currency options for the invoice. 

Delivery Number The delivery number, if available. 

Status The status of your invoice. 

Image Scan Allows you to upload an image to be attach to the 

invoice. 

Supplier Notes Use this field to enter a message for the invoice 

approver. 

Attachments Allows you to add various attachments to the 

invoice. 

 

• File – This option allows you to upload a 

document to the invoice. Use the Browse 

button to upload the file from your 

desktop. 

• URL – Use this option to include an 

external URL. 

• Text – Use this option to include 

additional text content. 

 

 
Ensure your document is a 

standard attachment file, not an 

image. Types of files that can be 

uploaded: .doc, .docx, .gif, .jpg, 
.jpeg, .pdf, .png, .tiff, .tif, .xls, 

.xlsx, .zip, and .txt. 
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Item Description 

Supplier Auto-populates from the PO with the supplier’s 

name. 

Remit To Auto-populates from the PO with the supplier’s 

remit to address. 

Customer Auto-populates from the PO with the customer 

name. 

Bill To Address Auto-populates from the PO with the bill to 

address. 

Ship To Address Auto-populates from the PO with the ship to 

address. 

Line Level Taxation Allows you to tax line items at different rates if 

enabled. 

Type Displays the line items type. 

Description Provides a description of the good(s) and/or 

service(s) purchased. 

Qty Shows the number of items. 

UOM Shows the unit of measure. 

Price Displays the unit price. 

Total Displays the item total. 

PO Line Provides the PO line number associated with the 

invoice. 

Contract Displays contract information, if any. 

Billing Displays the billing department associated with 

the PO. 

Subtotal Displays the total price of only the items 

Shipping Displays any shipping costs. 

Handling Displays any handling costs. 

Misc Displays any additional miscellaneous costs. 

Tax Code Provides an editable tax code for the supplier to 

select when invoicing. 
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Item Description 

Total Tax Displays the total tax amount. 

Total Displays the invoice total. 

 
 

Status Description 

Approved The invoice has been accepted for payment by 

the customer. 

Draft The invoice has been created, but hasn't been 

submitted to your customer yet. 

Pending The invoice is currently with a business approver. 

Processing The invoice is being processed by the AP 

department, and should be paid soon. 

Voided There's something wrong with the PO. Contact 

your customer to get the PO back on track. 

 

 

Creating a Credit Note 

If you need to create a credit note, it's best practice to specify a negative quantity for the item to be 

credited, rather than negative price. This is especially true if you're using 3-way matching, since before 

the credit can be processed, it will need to be matched against a receipt. 

 
1. From Purchase Orders, click the red coin ( ) icon in the Action’s column of the PO you wish 

you create a credit note from. 

2. Fill out any required fields marked with an asterisk (*). 

3. Use the Calculate button to see credit note totals prior to submitting. 

4. Click Submit. If you want to save a draft now, and continue to work on the form later, click Save 

as draft instead. 
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Item Description 

Credit Note # This is a required field. You will need to enter your 

credit note number. 

 

 
Invoice numbers cannot exceed 

16 characters. 

Credit Note Date The credit note date will default to the date the it is 

created. 

Payment Terms This field displays the code for your current 

payment terms that were agreed upon between 

your company and the supplier. 

Currency Displays the currency options for the invoice. 
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Item Description 

Delivery Number The delivery number, if available. 

Status The status of your invoice. 

Original Invoice # Provides a field to enter the original invoice #. 

Original Invoice Date Provides a date selector to enter the original 

invoice date. 

Image Scan Allows you to upload an image to be attach to the 

invoice. 

Supplier Notes Use this field to enter a message for the invoice 

approver. 

Attachments Allows you to add various attachments to the 

invoice. 

 
• File – This option allows you to upload a 

document to the invoice. Use the Browse 

button to upload the file from your 

desktop. 

• URL – Use this option to include an 

external URL. 

• Text – Use this option to include 

additional text content. 

 

 
Ensure your document is a 

standard attachment file, not an 

image. Types of files that can be 

uploaded: .doc, .docx, .gif, .jpg, 
.jpeg, .pdf, .png, .tiff, .tif, .xls, 

.xlsx, .zip, and .txt. 

Supplier Auto-populates from the PO with the supplier’s 

name. 

Remit To Auto-populates from the PO with the supplier’s 

remit to address. 

Customer Auto-populates from the PO with the customer 

name. 

Bill To Address Auto-populates from the PO with the bill to 

address. 

Ship To Address Auto-populates from the PO with the ship to 

address. 
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Item Description 

Line Level Taxation Allows you to tax line items at different rates if 

enabled. 

Type Displays the line items type. 

Description Provides a description of the good(s) and/or 

service(s) purchased. 

Qty Shows the number of items. 

UOM Shows the unit of measure. 

Price Displays the unit price. 

Total Displays the item total. 

PO Line Provides the PO line number associated with the 

invoice. 

Contract Displays contract information, if any. 

Billing Displays the billing department associated with 

the PO. 

Subtotal Displays the total price of only the items 

Shipping Displays any shipping costs. 

Handling Displays any handling costs. 

Misc Displays any additional miscellaneous costs. 

Tax Code Provides an editable tax code for the supplier to 

select when invoicing. 

Total Tax Displays the total tax amount. 

Total Displays the invoice total. 

 

 
Status Description 

Approved The invoice has been accepted for payment by 

the customer. 

Draft The invoice has been created, but hasn't been 

submitted to your customer yet. 

Pending The invoice is currently with a business approver. 
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Status Description 

Processing The invoice is being processed by the AP 

department, and should be paid soon. 

Voided There's something wrong with the PO. Contact 

your customer to get the PO back on track. 

 
 
 

Invoices 
Use the invoices page to work with orders from your customers. 

 

Invoice and Payment Status 

The invoice list displays all the invoices submitted by your organization to your Coupa customer. Here, 

you can check approval and payment status. 

 
1. From the Menu, click Invoices. 

 

 
2. To see invoices for a specific customer, select the customer from the dropdown list just under the 

menu button. The first time you use the invoices page, you'll have to choose a customer. The 

next time you visit, it'll return to the last customer you chose.  

 

 

The Invoices table lists all the invoices you've created for that customer. You can use the search bar to 

filter the list with a search term, or click the View dropdown to perform advanced filtering. See Custom 

Views for more info. 
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Column Description 

Invoice # This is the invoice order number generated by 

Coupa. 

Created Date This is the date the invoice was created on. 

Status This is the current status of the purchase order. 

See the Status List for more information. 

PO # This is the purchase order number generated by 

Coupa. 

Acknowledged You can choose to let your customer know that 

you received their PO by selecting the 

Acknowledged checkbox on the purchase order. 

When you select the checkbox, the current date 

appears in the Acknowledge column. 

 
This checkbox is a simple toggle, so you can also 

un-acknowledge an invoice by deselecting the 

checkbox. If you re-acknowledge at a later time, 

the new date will appear. 

Items List of items on the PO. 

Total This is the total amount of the purchase order. 

Unanswered Comments You can now make comments directly on the 

purchase order for your customers to see. If your 

customer has left comments that you haven't 

responded to, you'll get notified here. 

Actions Use the edit icon to make changes to the invoice. 

 

 

 
 

 

 

  

 

 

Accepted by Shashank Tandon on Oct 3rd, 2023 08:13am



Coupa Supplier Portal 

20 

 

 

 
 
 
 

Status Description 

Disputed The invoice has been disputed or rejected by your 

Coupa customer. You will receive an email 

notifying you of the approver’s reasons for 

rejecting the invoice in the Comments field. 

Disputed invoices cannot be edited in the CSP. 

 
A new invoice must be created with a different 

invoice number because Coupa will not accept 

duplicate invoice numbers. 

Draft The invoice has been created, but hasn't been 

submitted to your customer yet. 

On Hold The invoice has been put on hold for AP review. 

Pending Approval The invoice is currently with a business approver. 

Processing The invoice is being processed by the AP 

department, and should be paid soon. 

Voided There's something wrong with the PO. Contact 

your customer to get the PO back on track. 

 
 

 

Custom Views 
A custom view gives you the ability to create a set of advanced search filters, and save them. 

 

Creating a Custom View 
1. Go to the Coupa table you want to set up a custom view for. 

2. At the top of the table, click the View dropdown and select Create View. 

 

 
3. In the next screen, specify the settings you want to use for your custom view, including the 

filtering conditions to use, the columns to include, and the sorting criteria. If you want to build this 

view off of another view and tweak those settings, use the Start with view option under the 

General settings. Refer to Custom View Settings, below, for more details. 
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4. Click Save. 

 
Custom View Settings 

Customize these settings when creating or editing a custom view for a Coupa table. 

 
General Description 

Name The custom view name, visible from the View 

dropdown on top of the table. 

Visibility Decide whether this view can be visible to only 

you or all other Coupa users that can see the 

main table. 

Start with view Use this option to load another views settings and 

then tweak them to fit your needs for this view. 

 

 
Conditions Description 

Apply All of these conditions: Coupa displays results 

only for objects that meet all of the conditions you 

add in this list. 

 
Any of these conditions: Coupa displays results 

for objects that meet at least one of the conditions 

you add in this list. 
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Conditions Description 

Conditions Create conditions based on the data available in 

Coupa. 

 

 
Columns Description 

Available columns This list depends on the table you're working with 

in Coupa. You can select any of these columns to 

add into your custom view. 

Selected columns These are all the columns Coupa displays with 

this custom view. It displays them, from left to 

right, in the same order that you set them up here. 

 

 
Default Sort Order Description 

Default Sort Order Choose the column you want results sorted by 

and whether to sort them in ascending or 

descending order. 
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